
FEAT 1 Practical  FEAT 1 实操 

 

This tutorial leads you through a standard single-subject 

analysis with FEAT. There may be moments when you are 

waiting for programs to run; during those times take a look at 

the FEAT manual (in particular go to the User Guide and look 

at the FEAT in Detail section). We also suggest that you do 

read it carefully after the course, before using FEAT for 

analysing your own data. 

 

Contents: 

· Example real fmri-fluency dataset 

Perform a full first-level analysis of a single subject in an 

event-related language experiment. 

· Featquery 

Use featquery to interrogate results of the previous 

analysis and extract ROI measurements. 

 

Example real fmri-fluency dataset 

本教程将引导您完成 FEAT 的

标准单被试分析。你有时可能

需要等待程序运行。在这段时

间里，请查看 FEAT 手册（特别

是转到 User Guide，然后查看

Detail 部分）。 我们还建议您在

使用 FEAT 分析自己的数据之

前，在学习课程后仔细阅读该

手册。 

 

目录： 

· 真实 fmri-fluency 数据集示

例 

在一个事件相关的语言实

验中对单被试进行完整的

初级分析。 

· Featquery 

使用 featquery 询问先前分

析的结果并提取 ROI 测量

值。 

 

真实 fmri-fluency 数据集示例 

cd ~/fsl_course_data/fmri1/fluency_task 

 

The dataset fmri.nii.gz is from a language experiment. The TR 

is 4.2 seconds. The experiment is event-related and has three 

different types of events: 

数据集 fmri.nii.gz 来自一个语

言实验。TR 为 4.2 秒。该实验

采用事件相关设计，并且有三

种不同类型的事件： 

  

https://fsl.fmrib.ox.ac.uk/fsl/fslwiki/FEAT
https://fsl.fmrib.ox.ac.uk/fsl/fslwiki/FEAT


1. Word-generation events (WG): Here the subject is 

presented with a noun, say for example "car" and his/her 

task is to come up with a pertinent verb (for example 

"drive") and then "think that word in his/her head". The 

subject was explicitly instructed never to say or even 

mouth a word to prevent movement artefacts. 

 

2. Word-shadowing events (WS): Here the subject is 

presented with a verb and is instructed to simply "think 

that word in his/her head". 

 

3. Null-events (N): These are events where nothing happens, 

i.e. the cross-hair remains on the screen and no word is 

presented. The purpose of these "events" is to supply a 

baseline against which the other two event types can be 

compared. 

 

Note that there were no additional "instruction events" as part 

of the experiment. Each event was "its own instruction" in 

that the class of the word determines the task. This means that 

even the "shallow" word-shadowing events contain an 

element of grammatical decoding. 

1. Word-generation events

（WG）：在该事件中，向

被试展示一个名词，比如

说“汽车”，而他/她的任务

是由此生成一个相关的动

词（例如“drive”），然后

“在他/她的脑海里想着这

个词”。 明确指示该被试

从不说一个字以防止运动

伪影。 

 

2. Word-shadowing events

（WS）：在该事件中，向

被试显示一个动词，并指

示其简单地“在他/她的脑

海中想着该词”。 

 

3. Null-events（N）：在该事

件中，什么都没有发生，

即，只在屏幕上呈现十字

注视点而不显示任何单

词。这些“事件”的目的

是为比较其他两种事件类

型提供基线。 

 

请注意，实验中没有其他“指

令事件”。每个事件都是“自

己的指令”，因为单词的类别

决定了任务。这意味着，即使

“隐形”的 word-shadowing 

events 也包含语法解码元素。

  



Within one session, the events were presented at a constant 

ISI (Inter Stimulus Interval) of 6 seconds. For example, the 

first 72 seconds (twelve events) in this session may have 

looked like: 

在一个 session 中，事件以恒定

的 6 秒 ISI（刺激间隔）呈现。 

例如，此会话中的前 72 秒（十

二个事件）可能看起来像： 

N-WS-N-WS-N-WS-N-WG-N-WS-WG-N 

 

The randomisation of event types was "restricted" in the sense 

that there was an equal number (24) of each event type. In 

other words, at any given ISI each type of event was equally 

likely. 

 

The main question for this experiment was to see if the 

"deeper" language processing in the word-generation task 

would yield activations over and above that of the shallower 

processing in the word-shadowing task. But there are also 

other interesting questions you can ask of the data. So, let us 

get started with the analysis. 

事件类型的随机化是“受限的”，

要确保每种事件类型的数目相

等（24）。 换句话说，在任何给

定的 ISI 中，每种类型事件的出

现均具有相同的可能性。 

 

此实验的主要问题是查看单词

生成任务中的“较深层次”语言

处理是否会产生比单词隐藏任

务中较浅的处理更高的激活。 

但是您还可以对数据提出其他

有趣的问题。因此，让我们开始

进行分析。 

Feat & 

(Type Feat_gui &  if you are on a Mac). （Mac 上则输入 Feat_gui &） 

  



Data 

Feat starts by displaying the Data tab. Press Select 4D data 

and select fmri.nii.gz (don't just type "fmri.nii.gz" in the file 

select popup or you probably won't end up setting the full 

pathname; use the file-select icon on the right to select the 

input data). 

 

FEAT now knows how many time points (volumes) you have 

(106 in this dataset). The GUI will set the TR (time between 

3D volumes) using information in the NIFTI file, however 

this information is not always correct (depending on how the 

conversion to NIFTI was done). So you should always check 

that the value for TR is correct after the FMRI data is loaded. 

For these data it should be 4.2 seconds (you might get 4.199, 

and that is ok). 

 

数据 

壮举开始于显示 Data 选项卡。 

点击 Select 4D data，然后选择

fmri.nii.gz（不要仅在文件选择

弹出窗口中键入“fmri.nii.gz”，

否则您可能最终不会设置完整

路径名；请使用右侧的 file-

select 图标来选择输入数据）。 

 

FEAT 现在知道您有多少个时

间点（体积）（此数据集中为

106）。GUI 将使用 NIFTI 文件

中的信息来设置 TR（3D 体积

之间的时间），但是该信息并不

总是正确的（取决于转换为

NIFTI 的方式）。因此，加载

FMRI 数据后，您应始终检查

TR 的值是否正确。对于这些数

据，应该为 4.2 秒（您可能会得

到 4.199，这没关系）。 

  



The High pass filter cutoff is preset to 100secs. This is chosen 

to remove the worst of the low frequency trends, and is also long 

enough to avoid removing the signal of interest. In general you 

need to ensure that this is not set lower than your maximum 

stimulation period. For a random-order event-related design 

there is no clear "stimulation period" so in order to assess what 

the cutoff should be one needs to analyse the frequency-content 

of our expected activations (remember that the design matrix 

embodies what we expect to see in the brain). Leave it at the 

default for now and we'll come back to it when we have 

specified the design. 

 

 

Pre-stats and Stats 

Press the Pre-stats tab to look at the preprocessing steps. For 

this experiment we will change Spatial smoothing FWHM 

(mm) to 7mm, which is slightly more than we normally 

recommend. All the other default pre-processing steps are 

fine for this dataset. 

 

Setting up the design matrix 

Select the Stats tab and press Full model setup to setup the 

GLM details. 

Change the Number of EVs to 2 (we have two conditions to 

model separately - Word-generation and Word-shadowing). 

 

High pass filter cutoff预设为100

秒。选择此项可以消除最坏的

低频趋势，并且其长度还足以

避免除去感兴趣的信号。通常，

您需要确保将其不低于于最大

刺激期。对于随机事件相关的

设计，没有明确的“刺激期”，

因此为了评估临界值，需要分

析预期激活的频率含量（请记

住，设计矩阵体现了我们期望 

在大脑中看到的结果）。现在将

其保留为默认值，指定设计后

我们将重新设置它。 

 

预统计和统计 

按下 Pre-stats 选项卡以查看预

处理步骤。对于本实验，我们将

Spatial smoothing FWHM (mm)

更改为 7mm，这比我们通常建

议的略大。对于此数据集，其他

预处理步骤设置保留为默认值

即可。 

 

设置设计矩阵 

选择 Stats 选项卡，然后点击

Full model setup来设置GLM详

细信息。 

将 Number of EVs 更改为 2

（我们有两个要分别建模的条

件- Word-generation 和 Word-

shadowing）。

  



Setup EV1 (Word-generation): First chose a sensible name 

like for example Gen for it and change Basic shape to 

Custom (3 column format) and select the file 

word_generation.txt. Later (when you wait for FEAT to finish 

the analysis) we will return to this file and make sure you 

understand what is in it. Next set Convolution to Double-

Gamma HRF which corresponds to the HRF you saw in the 

talks. Leave the setting for Phase, to the default but unset 

Add temporal derivative. We would normally recommend 

leaving it set (and we will come back to set it) but in order to 

obtain a very simple initial design we will unset it for now. 

 

Setup EV2 (Word-shadowing): Chose a name (for example 

Shad and change Basic shape to Custom (3 column format) 

and this time select the file word_shadowing.txt. Same as for 

EV1 set Convolution to Double-Gamma HRF, unset Add 

temporal derivative and leave everything else as the defaults. 

 

 

Setting up contrasts 

Now set up the Contrasts (click on the Contrasts & F-tests 

tab). Set the Number of contrasts to 5 and enter the 

following contrasts: 

设置 EV1 (Word-generation)：

首先为其选择一个明智的名

称，例如 Gen，然后将 Basic 

shape 更改为 Custom（3 列格

式），然后选择文件

word_generation.txt。 稍后

（当您等待 FEAT 完成分析

时），我们将返回此文件并确

保您了解其中的内容。接下

来，将 Convolution 设置为

Double-Gamma HRF，它与您

在课堂中中看到的 HRF 相对

应。 将 Phase 设置保留为默认

设置，但取消设置 Add 

temporal derivative。通常，我

们建议保留它的设置（我们后

面将再次设置它），但是为了

获得一个非常简单的初始设

计，我们现在将其取消设置。 

 

设置 EV2 (Word-shadowing)：

选择一个名称（例如 Shad，并

将 Basic shape 更改为 Custom

（3 列格式），然后选择文件

word_shadowing.txt。与 EV1

相同，将 Convolution 设置为

Double-Gamma HRF，取消设

置 Add temporal derivative，并

将其他所有内容保留为默认

值。 

 

 

设置对比 

现 在 设 置 Contrasts （ 单 击

Contrasts & F-tests 选项卡）。将

Number of contrasts 设置为 5 并

输入以下对比：

  



1. Name the first contrast Generation. Set the contrast to be 

sensitive to the activation in word-generation above and 

beyond that in rest. [1 0] 

 

2. Name the second contrast Shadowing. Set the contrast to 

be sensitive to the activation in word-shadowing above 

and beyond that in rest. [0 1] 

 

3. Name the third contrast Mean. Set the contrast to be 

sensitive to the mean activation in word-generation and 

word-shadowing being larger than in rest. [1 1]  

 

4. Name the fourth contrast Shad > Gen. Set the contrast to 

be sensitive to the activation in word-shadowing above 

and beyond that in word-generation.[-1 1]  

 

5. Name the fifth contrast Gen > Shad. Set the contrast to be 

sensitive to the activation in word-generation above and 

beyond that in word-shadowing. [1 -1] 

 

1. 将 第 一 个 对 比 命 名 为

Generation。设置对比使其

对 word-generation 大于静

息的激活敏感。[1 0] 

 

2. 将 第 二 个 对 比 命 名 为

Shadowing。设置对比使其

对 word-shadowing 大于静

息的激活敏感。[0 1] 

 

3. 将第三个对比命名为 Mean。 

设 置 对 比 使 其 对 word-

generation 和 word-

shadowing 的平均激活大于

静息的激活敏感。[1 1] 

 

4. 将 第 四 个 对 比 命 名 为

Shad>Gen。设置对比使其对

word-shadowing 大于 word-

generation 的激活敏感。 

[-1 1] 

 

5. 将第五个对比度命名为 Gen> 

Shad 。设置对比使其对

word-generation 大于 word-

shadowing 的激活敏感。 

[1 -1] 

  



Next set up an F-test. Set the Number of F-tests to 1 and 

select the first two contrasts. This spans both conditions and 

will show you any areas where there is significant activation 

by Word-generation AND/OR Word-shadowing. Thus the 

sixth output colour overlay image produced will show where 

either generation or shadowing activation (or both) occurs; i.e. 

it will show both on a single image. 

 

 

If you would set up a second F-tests that has contrasts 3 and 

4 selected, what would the resulting map show? 

· Regions in which both the mean and the difference between 

word shadowing and word generation contrasts showed 

significant effects 

· Regions in which either the mean contrasts, or the difference 

between word shadowing and word generation (regardless 

of the direction of the difference) showed significant effects 

Correct! The F-test is sensitive to both Shad > Gen and to 

Gen > Shad, and also to both negative and positive mean 

effects 

· Regions in which either the mean contrasts, or the difference 

between word shadowing and word generation (only when 

Shad > Gen, but not for Gen > Shad) showed significant 

effects 

 

接下来设置一个 F-test。将

Number of F-tests 设置为 1，然

后选择前两个对比。这涵盖了

两种情况，并会向您显示

Word-generation 和/或 Word-

shadowing 产生显着激活的任

何区域。因此，生成的第六个

彩色叠加图像输出将显示

generation 或 shadowing 的激活

（或两者都有）位置；即它将

同时显示在单个图像上。 

 

如果您要设置第二个 F 检验，

并选择了对比 3 和 4，那么结果

图将显示什么？ 

· word shadowing 和 word 

generation 对比间均值和差

异都显着的区域 

· word shadowing 和 word 

generation 对比间的均值或

差异（不论是哪个比较方向）

显著的区域 

正确！ F 检验对 Shad> Gen

和 Gen> Shad 均敏感，对负

和正均值均敏感 

· word shadowing 和 word 

generation 对比间的均值或

差异（仅 Shad> Gen，而非

Gen> Shad）显著的区域 

  



Bonus question: Will the F-test with contrasts 1 and 2, and the 

F-tests with contrasts 3 and 4 result in the same maps or in 

different maps? 

 

Answer: The F-test asks whether any combination of the 

selected contrasts explains a significant portion of the 

variance in the data. Any contrast that can be created by 

combining contrasts 1 and 2 can also be created by combining 

contrasts 3 and 4 and the other way around. For example, 

contrast 3 can be created by adding contrasts 1 and 2. So an 

F-test with contrasts 3 and 4 would end up testing all the same 

possible combinations as an F-test with contrasts 1 and 2 and 

hence give exactly the same results. Feel free to add an 

additional F-test with contrasts 3 and 4 to test this. 

 

Press View design. Make sure you understand the resulting 

design matrix. Time goes down the page, with every 10 TRs 

ticked off on the left. The red bar shows the width of the 

highpass filter (the amplitude of any signal much longer than 

it will get reduced). There are 2 columns in the design 

corresponding to our predictions about BOLD activity from 

Word-generation and Word-shadowing respectively.  

 

额外的问题：对比 1 和 2 的 F

检验，以及对比 3 和 4 的 F 检

验会得出相同的图谱还是不同

的图谱？ 

 

答案：F 检验询问所选对比的任

何组合是否解释了数据差异的

很大一部分。可以通过组合对

比 1 和 2 来创建的任何对比，

也可以通过组合对比 3 和 4 来

创建，反之亦然。例如，可以通

过添加对比 1 和 2 来创建对比

3。因此，对比 3 和 4 的 F 检验

与对比 1 和 2 的 F 检验最终将

测试相同的可能组合，因此得

出的结果完全相同。你可以运

行额外的对比 3和 4的 F-test来

进行测试。 

 

点击 View design。确保您了解

最终的设计矩阵。时间轴沿页

面方向向下，左侧每 10 个 TR

都被选中。 红色条显示高通滤

波器的宽度（幅值比它长得多

的信号会被消减）。在设计中有

2列分别对应于我们根据Word-

generation 和 Word-shadowing

对 BOLD 活动的预测。

  



Hopefully they will be familiar from the talk you have just 

heard. The contrasts appear at the bottom of the image, with 

the F-test to the right of the contrasts. Note that you can make 

the design matrix display disappear just by clicking on it once. 

For now, leave the design matrix display up (Press View 

design again if necessary). 

 

Temporal derivatives 

Now, return to the EVs tab and FOR BOTH EVs select Add 

temporal derivative. 

 

Press View design again. You now see 4 columns with 

columns 1 and 3 being the same as before and column 2 and 

4 being "new". These are the temporal derivatives that are 

used to correct for timing errors caused either by slight 

experimental errors in synchronising the times of the scanner 

with the stimulus presentation and/or inter-subject differences 

in the delay inherent in the HRF. Now press "Done" and 

dismiss the view of the design matrix. 

希望你在刚才课堂上已经对它

们有所熟悉。对比出现在图像

的底部，F 检验在对比的右边。 

请注意，只需单击一下，就可以

使设计矩阵显示消失。现在，保

留设计矩阵显示（如有必要，请

再次点击 View design）。 

 

 

时间导数 

现在，返回到 EVs 选项卡，并

为两个 EV 选择 Add temporal 

derivative。 

 

 

再次点击 View design。现在，

您将看到 4 列，其中第 1 列和

第 3 列与之前相同，第 2 列和

第 4 列为“新”。 这些是时间导

数，用于校正在将扫描仪的时

间与刺激信号同步时出现的轻

微实验错误，和/或 HRF 固有延

迟的被试间差异导致的时间误

差。现在点击 Done 并关闭设计

矩阵的视图。 

 

  



Do you remember that we said we should return to the issue 

of High pass filtering once we knew the design (and with 

that the expected frequency content of the signal we 

expect/hope to see)? Now the time has come. Press the Data-

tab to make sure that High pass filter cutoff (s) is set to 100. 

Next press the Misc-tab where there will be a button saying 

Estimate High Pass Filter. Press this button and then go 

back to the Data-tab to see what has happened. This should 

now have changed to 90 seconds. FSL has calculated this for 

you by analysing the frequency content of the design and then 

selected a cutoff so that 90% of our expected signal is still in 

the data after filtering. (N.B. that it is just a fluke that 90% 

happened to translate into 90 seconds in this particular case) 

 

Look at the Post-stats section - the defaults are fine; cluster-

based thresholding will be carried out. 

 

您还记得我们曾经说过，一旦

我们了解了设计（和我们希望

看到的信号的预期频率内容），

我 们 就 会 回 到 High pass 

filtering 吗？现在是时候了。按

Data 选项卡，确保将 High pass 

filter cutoff (s)设置为 100。接下

来，点击 Misc 选项卡，其中有

一个按钮显示 Estimate High 

Pass Filter。点击此按钮，然后

返回到 Data 选项卡查看发生了

什么。 现在应该更改为 90秒。 

FSL 已通过分析设计的频率内

容为您计算了这一点，然后选

择了一个截止值，以便过滤后

数据中仍存在 90％的预期信号。 

（注：90％转化为 90 秒只是本

实例中的一个巧合。） 

 

查看 Post-stats 部分-保留默认

值即可；我们将执行基于群集

的阈值设置。 

  



What does high pass filtering do to your data? 

· It removes frequencies that are faster than the cutoff, 

which mainly contain noise 

· It removes frequencies that are slower than the cutoff, in 

order to remove noise 

Correct! Fluctuations that are slower than the cutoff are 

filtered out of the data. This is useful to remove scanner 

drift (a slow change in the measured signal from the start 

to the end of the scan) 

· It performs temporal smoothing of the timeseries 

高通滤波对您的数据有什么作

用？ 

· 它去除了比截止频率更快

的频率，该频率主要包含噪

声 

· 它去除比截止频率慢的频

率，以去除噪声 

正确！比截止频率慢的波动

将从数据中滤除。这对于消

除扫描仪漂移（从扫描开始

到结束的测量信号缓慢变

化）很有用。 

· 它执行时间序列的时间平

滑 

  



Registration 

Select the Registration tab. By default FEAT will register the 

middle-timepoint FMRI image (saved as example_func in 

the .feat output directory) to the standard space template. We 

recommend in general turning on the Main structural image 

option so that the lowres FMRI image is first registered to a 

brain-extracted highres structural image from the same 

subject; this highres image is then registered to the standard 

space template, and then the two registrations are combined 

to give an example_func2standard.mat transform which can be 

used later to resample the FMRI stats into standard space. 

 

Set the Main structural image file to structural_brain.nii.gz with 

7 DOF (note that we have already run BET on this, and in 

order to save time in this practical session we are not using 

the BBR method, but we strongly recommend that BBR is 

used generally). Leave Standard space turned on with 

MNI152_T1_2mm_brain.nii.gz selected and set the DOF to 12. 

Instead of the linear (12 DOF) registration we are using here, 

the more accurate nonlinear registration is normally 

recommended for registration to MNI space by selecting the 

"nonlinear" option, but we use linear here as it is faster for 

this practical. 

配准 

选择 Registration 选项卡。默认

情况下，FEAT 将把中间时间点

的 FMRI 图像（在.feat 输出目

录中保存为 example_func）配准

到标准空间模板。我们建议通

常打开 Main structural image 选

项，以使低分辨率 FMRI 图像

首先与来自同一被试者的大脑

提取后的的高分辨率结构图像

配准。然后，将此高分辨率图像

配准到标准空间模板，然后将

这两步配准组合在一起，以给

出 example_func2standard.mat

变换，该转换可在以后用于将

FMRI 统计信息重采样到标准

空间中。 

 

 

将 Main structural image 设置为

7 DOF 的 structural_brain.nii.gz

（请注意，我们已经对此进行

了 BET，并且为了节省时间，

在本练习中我们不使用 BBR

方法，但是通常我们强烈建议

您使用 BBR）。在选择

MNI152_T1_2mm_brain.nii.gz

的情况下，保持 Standard space

为打开状态，并将 DOF 设置

为 12。我们在这里使用线性

（12 DOF）配准以节省时间，

但通常我们建议你选择更加精

确的“非线性”选项。 

  



Go! 

You are now ready to run FEAT. Press Go. A web browser 

should appear, and as FEAT completes the different stages of 

processing, you will see messages appear in the Log section. 

Whether the web browser (and indeed the FEAT GUI) is left 

displayed or is closed, FEAT will continue to run in the 

background. For now, leave the web browser open so that you 

can monitor FEAT's progress. FEAT will take 2-5 minutes to 

complete. 

 

While you wait 

Take a look at the flow diagram below which summarises all 

of the steps that you just set up in Feat. Hopefully it will help 

you to see the big picture, and avoid getting bogged down in 

the details: 

GO！ 

您现在可以运行 FEAT 了。点击

Go。 应该会弹出一个网络浏览

器，并且随着 FEAT 完成处理的

不同阶段，您将在 Log 部分看

到不同消息的出现。无论 Web

浏览器（甚至是 FEAT GUI）是

处于显示状态还是处于关闭状

态，FEAT 都会继续在后台运行。 

现在，让网络浏览器保持打开

状态，以便您可以监控 FEAT 的

进度。FEAT 需要 2-5 分钟才能

完成。 

 

在你等待的时候 

查看下面的流程图，该流程图

总结了您刚刚在 Feat 中设置的

所有步骤。 希望它可以帮助您

纵览全局，并避免在细节中陷

入困境： 

 

  



Whilst FEAT is running, run FSLeyes to have a quick look at 

the different images mentioned above: start by looking at 

structural_brain.nii.gz, and then view fmri.nii.gz. Note that when 

viewing the 4D image you can see the image time series as a 

movie by pressing on the movie icon ( ), and you can also 

see time series plots by pressing View > Timeseries. 

 

Create a mask to probe statistics 

Whilst FEAT is still running, we will now use FSLeyes to 

create a mask in standard space that will be used later to find 

out about activation statistics from within the mask. An 

alternative method to create a mask was explained in the 

Registration practical. 

 

1. Reopen FSLeyes and load the standard space template 

image $FSLDIR/data/standard/MNI152_T1_2mm ($FSLDIR is 

an environment variable indicating the directory in which 

FSL is installed, you can type echo $FSLDIR  to see what 

this is set to). Inside FSLeyes you can use the File -> Add 

standard menu option to find these standard space images 

quickly. 

 

 

在运行 FEAT 的同时，运行

FSLeyes 以快速查看上述不同

的图像：首先查看

structure_brain.nii.gz，然后查

看 fmri.nii.gz。 请注意，在查

看 4D 图像时，您可以通过按

电影图标（ ）来以电影的形

式查看图像时间序列，也可以

通过点击 View > Timeseries 来

查看时间序列图。 

 

创建掩码以探查统计信息 

当 FEAT 仍在运行时，我们现在

将使用 FSLeyes 在标准空间中

创建一个掩板，稍后将使用该

它从掩板中查找有关激活的统

计信息。在配准实操中介绍了

创建掩板的另一种方法。 

 

 

1. 重新打开 FSLeyes 并加载

标准空间模板图像

$ FSLDIR / data / standard / 

MNI152_T1_2mm

（$ FSLDIR 是一个环境变

量，指示 FSL 的安装目

录，您可以键入 echo 

$ FSLDIR 来查看其设

置）。在 FSLeyes 内，您可

以使用 File -> Add standard

菜单选项来快速查找这些

标准空间图像。
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2. Open the atlas panel via Settings -> Ortho View 1 -> Atlas 

panel, and enable the Harvard-Oxford cortical, Harvard-

Oxford subcortical and Juelich Histological atlases. Move 

the cursor around a little in the standard brain and see how 

the labels and numbers in the atlas tool window changes. 

If you have a favourite part of the brain and you happen to 

know where it is you can move the cursor there and see if 

the atlas tool agrees with you.  

 

3. Now select the Atlas search tab in the atlas panel, and 

choose the Juelich Histological Atlas from the list on the 

left. You will now see a list of all the structures in that atlas 

on the right.  

 

4. Type ba4 in the text box above the structure list to filter the 

structures that are shown. Click the check boxes next to 

GM Broca's area BA44 L and GM Broca's area BA45 

L. 

2. 通过 Settings -> Ortho View 

1 -> Atlas 面板打开图集面

板 ， 然 后 启 用 Harvard-

Oxford cortical, Harvard-

Oxford subcortical 和 

Juelich Histological 图集。在

标准大脑中稍微移动一下

光标，然后查看图集工具窗

口中的标签和数字如何变

化。如果您有最爱的大脑部

分，并且碰巧知道它在哪里，

则可以将光标移到那里，然

后查看图集工具是否与您

的认知一致。 

 

3. 现在，在图集面板中选择

Atlas search 搜索选项卡，然

后 从 左 侧 列 表 中 选 择

Juelich Histological Atlas。 

现在，您将在右侧的图集中

看到所有结构的列表。 

 

4. 在结构列表上方的文本框

中键入 ba4 以过滤显示的结

构。单击 GM Broca 的 BA44 

L区域和GM Broca的BA45 

L 区域旁边的复选框。 

  



5. You will notice that in the FSLeyes overlay list, two 

images have been added with name corresponding to the 

regions you just selected. If you select one of those and 

then move the cursor around you will notice its intensity 

values in changing between 0 and 100. These values 

reflect the probability that a given voxel (cursor position) 

is indeed part of that structure.  

 

6. Press the save icon (  ) next to the image 

juelich/prob/GM Broca's area BA44 L in the overlay list 

and save the image to a file called BA44. Repeat this process 

for BA45.  

 

7. What we will do next is to create a mask which has the 

value 1 for each voxel that has a 50% or greater chance of 

belonging to BA44 and/or BA45. We do this by typing (in 

the terminal window): 

 

5. 您会注意到，在 FSLeyes 覆

盖列表中，添加了两个图像，

其名称与您刚选择的区域

相对应。如果选择其中一个，

然后在周围移动光标，您会

注意到其强度值在 0 到 100

之间变化。这些值反映了给

定体素（光标位置）确实是

该结构的一部分的可能性。 

 

6. 点击覆盖列表中图像

juelich/prob/GM Broca's area 

BA44 L 旁边的保存图标

（ ），然后将图像保存到

名为 BA44 的文件中。对

BA45 重复此过程。 

 

7. 接下来，我们将创建一个掩

板，对于每个具有 50％或更

大的机会属于 BA44 和/或

BA45 的体素，其值为 1。 

我们通过在终端窗口中输

入以下内容来实现： 

fslmaths BA44 -add BA45 -thr 50 -bin Broca 

 

The end result of this is a file named Broca.nii.gz that we will 

later use as a mask to plot time-series of our results. If you 

want to convince yourself that this file indeed contains what 

it should you can type and have a look. 

最 终 的 结 果 是 一 个 名 为

Broca.nii.gz 的文件，稍后我们

将其用作掩板以绘制结果的时

间序列。如果确认该文件确实

包含相关的内容，你可以输入： 

  



fsleyes -std Broca -cm red 

Look at the EV specification 

Lastly, whilst FEAT is running take a look at the files that we 

used to specify our design, i.e. word_generation.txt and 

word_shadowing.txt. We do this by typing (still in the terminal 

window): 

查看 EV 规格 

最后，在 FEAT 运行时，请查

看用于指定设计的文件，即

word_generation.txt 和

word_shadowing.txt。 我们通

过键入（仍然在终端窗口中）

来做到这一点： 

more word_generation.txt 

The more command will show you the contents of the file (type 

q to quit if the terminal doesn't give you your prompt back). 

Once you've finished looking at word_generation.txt, run more  

word_shadowing.txt  to look at the timing information for the 

word shadowing task. 

 

There are three columns in these files, what information 

does the first column contain? 

· Start time of the event (in seconds) 

Correct! Start times are relative to the start of the scan. In 

event-related studies like this it is crucial to get the timings 

right (down to a second) so it is often a good idea to have 

the start of stimulus presentation to be triggered by the 

scanner. 

· Duration of the event (in seconds) 

· Magnitude of the expected response 

more 命令将向您显示文件的内

容（如果终端没有给予你提

示，则键入 q 退出）。查看完

word_generation.txt 后，请运行

more word_shadowing.txt 来查

看 word shadowing 任务的时间

信息。 

 

这些文件中有三列，第一列包

含哪些信息？ 

· 事件的开始时间（单位 s） 

正确！开始时间是相对于

扫描开始的时间。在此类

事件相关的研究中，正确

计时（缩短至一秒）至关

重要，因此由扫描仪触发

刺激呈现通常是一个好主

意。 

· 活动持续时间（单位 s） 

· 预期响应的幅度 

  



While FEAT is running it will display STILL RUNNING in 

the main FEAT report page, which is replaced by Finished 

at ... when it is done. Once FEAT has finished, look carefully 

at the various sections of the web page report, including 

motion correction plots in the Pre-stats section, the colour-

rendered activation images and timeseries plots in the Post-

stats section, and the Registration results. Note that if you 

click on the activation images you get a table of cluster co-

ordinates. 

 

Featquery 

Featquery allows you to calculate certain data statistics, either 

at a voxel of interest, or averaged over a region of interest 

using a mask. We will use the standard-space mask which we 

created earlier. Start up Featquery from the terminal: 

 

当 FEAT 运行时，它将在

FEAT 主报告页面中显示

STILL RUNNING，完成后将

替换为 Finished at...。 FEAT

完成后，请仔细查看网页报告

的各个部分，包括 Pre-stats 部

分中的运动校正图，Post-stats

部分中的彩色渲染激活图像和

时间序列图以及配准结果。 

请注意，如果你单击激活图

像，则会得到一个群集坐标

表。 

 

Featquery 

Featquery 允许您计算特定的数

据统计信息，既可以在感兴趣

的体素上计算，也可以使用掩

板在感兴趣区域上取平均值。 

我们将使用我们之前创建的标

准空间掩板。从终端启动

Featquery： 

Featquery & 

(or Featquery_gui &  if you are on a Mac). 

 

Select the fmri.feat directory created by your first analysis on 

the fmri-fluency dataset. 

(Mac 上则输入 Featquery_gui &) 

 

 

选择你首次对 fmri-fluency数据

集分析时创建的 fmri.feat 目录。 

  



Featquery automatically reads the FEAT directory and gives 

you the appropriate options as to which statistics you can 

choose to investigate. 

 

1. Select the following statistics for the contrast that looks at 

activation for word-generation (i.e. the [1 0] contrast), the 

contrast that looks at activation for word-shadowing (i.e. 

the [0 1] contrast) and the contrast that looks at activation 

for word-generation over and above word-shadowing (i.e. 

the [1 -1] contrast), i.e. contrasts number 1, 2 and 5: 

· stats/cope (unthresholded contrast of parameter 

estimate) 

· stats/tstat (unthresholded t statistics) 

· stats/zstat (unthresholded z statistics) 

· thresh_zstat (thresholded z statistics) 

 

 

2. In the Input ROI selection panel, enter the mask that you 

created earlier (i.e. Broca.nii.gz) as the Mask Image (note - 

Featquery can take either a standard-space mask OR a 

lowres one in the original dataspace OR a mask in the 

space of the structural image) 

 

Featquery 自动读取 FEAT 目录

并为您提供适当的选项，以供

您选择要调查的统计信息。 

 

 

1. 选择以下统计数据，用于查

看 word-generation 激活的

对比（即[1 0]对比），word-

shadowing 激活的对比（即

[0 1] 对 比 ） 和 word-

generation 激活大于 word-

shadowing 的对比（即[1 -1]

对比），即对比 1、2 和 5： 

· stats/cope（未阈值化的

参数估计对比） 

· stats / tstat（未阈值化的

t 统计） 

· stats / zstat（未阈值化的

z 统计） 

· thresh_zstat（阈值化的 z

统计） 

 

2. 在 Input ROI selection 面板

中，输入您之前创建的掩

板（即 Broca.nii.gz）作为

Mask Image（注意-

Featquery 可以在原始数据

空间里使用标准空间掩板

或低分辨率掩板，也可以

在结构图像空间里使用掩

板。）

  



3. In the Output options section, select the Convert 

PE/COPE values to % option 

 

4. Select the Do not binarise mask (allow weighting) 

option 

 

5. Select an atlas (inside the Output options section), for 

example the Harvard-Oxford Cortical Structural Atlas. 

The local maxima voxels reported by Featquery will be 

related to structures in the selected atlas. 

 

6. Press Go and a web browser showing the estimated 

statistics should popup shortly (possibly after a minute or 

two). 

 

 

3. 在 Output options 部分中，

选择 Convert PE/COPE 

values to %选项 

 

4. 选择 Convert PE/COPE 

values to %选项 

 

5. 选择一个图集（在 Output

选项部分内），例如

Harvard-Oxford Cortical 

Structural Atlas。Featquery

报告的局部最大体素将与

所选图集中的结构相关。 

 

6. 按下 Go 键，然后会弹出一

个显示估计统计信息的

Web 浏览器（可能在一两分

钟之后）。 

 

 

  



The resulting web page will contain a table summarizing each 

of the statistics that you asked Featquery to report on in step 1. 

The first column gives the statistic name. The second column 

gives the number of non-zero voxels in the mask. The next 

group of columns gives a summary of the distribution of values 

within the mask. Finally, the last group of columns contains the 

position of the maximum in voxel space, in mm space, and in 

the atlas space selected in step 5. Plots of the timeseries at the 

maximum z-stats are available by clicking the link labeled 

"Masked time series plot" just below the image of the mask at 

the top of the page. 

 

What does the second column ("# voxels") tell you for the 

copes and t-stats images? 

· The number of voxels with statistically significant 

activation 

· The number of voxels with any activation, whether it 

reaches the statistical threshold or not 

· The number of voxels in the Broca mask 

Correct! Even in voxels without any brain activation, there 

will be some correlation between the contrast timeseries 

and the image noise, leading to spurious non-zero copes 

and t-stats. Hence, all voxels within the Broca mask will 

be non-zero (except for voxels outside of the brain mask). 

所得的网页将包含一个表，该

表汇总了您在步骤 1 中要求

Featquery 报告的每个统计信息

第一列提供了统计信息名称。

第二列给出了掩板中非零体素

的数量。下一组列概述了掩板

中值的分布。最后一组列包含

在步骤 5 中选择的体素空间，

mm 空间和图集空间中最大值

的位置。可通过单击页面顶部

掩板图像下方标记为"Masked 

time series plot"的链接来获得

最大 z 统计量的时间序列图。  

 

 

第二列（"# voxels"）为您提供

了有关 copes 和 t-stats images

的什么信息？ 

· 具有统计显着性激活的体素

数量 

· 任何激活的体素数量，无论

是否该激活达到统计阈值 

· Broca 掩板中的体素数 

正确！即使在没有任何大脑

激活的体素中，对比时间序

列和图像噪声之间也会存在

一定的相关性，从而导致虚

假的非零值和 t-stats。 因此，

Broca 掩板中的所有体素都

将不为零（掩板外的体素除

外）。 

 

 

—— THE END —— 


